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Good Morning! 
 Day 2 

Communication &  
Internet 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
“Computers are intrinsically compelling for young children. The sound and graphics gain 
children’s attention. Increasingly, young children observe adults and older children 
working on computers and they want to do it too. Children get interested because they 
can make things happen with computers. Developmentally appropriate software engages 
children in creative play, mastery learning, problem solving, and cooperation.” 

NAEYC “Technology and Young Children—Ages 3 through 8” 1996 
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Trainer Notes Day 2  Set-up Checklist 
 
 

Prior to Arriving 
 Double check all Web sites being used for the days session. 
 Print out copies of rebus sentences. 
 Create an laminated sentence strips for Internet writing activity. 
 Pack music CDs to set an upbeat training mood. 
 Pack floppy disks in case shared drive space is not available. 

 
 
Once You Arrive 

 Test to make sure that you can download the software for the Learning Letters 
activity. It is the Letter Machine Activity from the Bailey’s Bookhouse software. 
Riverdeep allows users to download portions of the software to try it for free. 
http://www.riverdeep.com/products/downloads/free_downloads.jhtml 

 Check the following software on each machine and make sure that it opens and has 
the appropriate settings: Kidspiration, Word, Powerpoint, Graph Club, Kid Pix. 

 Check Internet access on each machine. 
 Test printing from each machine and make sure there is paper and ink to print 
 Make sure that each machine can access a shared folder or drive on the server. 

Create a folder on the shared drive to save material to. 
 Print sign-in sheet and set out 
 Set out group management tool poster as well as individual management tools (red 

cups) 
 Set out sticky notes and markers for each computer 
 Make sure that your computer can project and that the first activities of the day 

are open and minimized on the screen. 



Ready for Reading, Technology Tools in the Pre K – 1st Grade Classroom                                  Trainers Manual  
 

Copyright  2004  i3 Training Services  Inc. 

Trainer Notes  All days   Routine Tasks 
 

 Check end of the day notes from the previous day for anything that needs to be 
prepared prior to students arriving 

 Check supplies such as sticky notes, markers and candy. 
 Make sure to read over the email reflections that participants send so that you can 
respond to concerns or positives either whole group or privately. 

 
Technology Management Strategy at Student Workstations: 
Red cups – Give each participant a red cup to place on or beside the computer.  The red 
cup will be used to indicate the need for help.  Participants will be asked to put the red 
cup up on the computer when they need help.  The trainer will use the red cup, saying 
cups up or cups down, to indicate when participants have finished a process during the 
lesson. 
 
Kiosk: 
There is a kiosk, created in PowerPoint, for each day of the training.  Have this playing 
as the participants enter the training room.  Here they will find the daily objectives, 
software used, daily assignments including the daily diary topic and any information the 
trainer wants them to have.  Update before each training. Kiosks can be downloaded 
from the trainer web site at http://www.i3forteachers.com/readyforreading/  
 
Music: 
Have a music CD playing as participants enter the room and are participating in the 
morning assignments.  
 
E-Mail & “Sites of the Day”: 
Trainers send email messages to the participants each day after Day 1.  The suggested 
messages can be found with the Trainer materials.  You will be sending them an email 
that has questions pertaining to the reading assignments and several internet “Sites of 
the Day.” These are general reference sites for teachers. Spend a few minutes each 
morning going over the sites to familiarize participants with them.  Emails and “Sites of 
the Day” can be found on the trainer CD can be downloaded from the trainer web site at 
http://www.i3forteachers.com/readyforreading/ 
 
Daily Diary: 
Participants are asked to reflect in a daily diary.  After day 1 this is completed as the 
participants arrive.  It is part of the daily assignments listed on the kiosk.  Daily Diary 
topics can be found with the Trainer materials.  Each day participants will be asked to 
group share their daily diary reflections.  After group share the leader of the day will 
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report to the whole group what was discussed.  This is a time for the trainer to 
understand what issues the participants are facing both in the training session and in 
their classrooms.  The trainer will lead the discussions providing input on the “hot” 
topics. 
Daily Diary topics can be found on the trainer CD can be downloaded from the trainer 
web site at http://www.i3forteachers.com/readyforreading/  
 
Professional Readings - 
Daily participants are required to read from the appendix of the notebook. Questions 
regarding the readings are part of the email activity.  
Day 1 - Appendix Page 1-7 
Day 2 - Appendix Page 8-16 
Day 3 - Appendix Page 17-24 
 
 
Daily Diary Activity 
 
Trainer Notes:  The diary activity assess participant’s thoughts and attitudes about 
curriculum and technology integration.  This activity is completed daily with a new 
question for reflection.   
 
Writing Topic for Day 1 Diary 

How have you used technology with early elementary students in the past? What 
worked? What didn't? Why? Give details! 
 

Small Group / Whole Group Sharing of Daily Diary 
• Move teams to small groups to discuss the diary reflection. 
• Small groups share whole group responses to the diary reflection. 
• Participants should print 2 copies of the daily diary.  One copy is submitted to the 

trainer and one is placed in their folder. 
• Use the student check sheet to check when assignment is complete. 

 
Trainer Notes: 

• Daily Diary whole group sharing is an excellent time for the trainer to address 
concerns of the participants.  Be prepared to listen carefully and respond 
positively when necessary.  Don’t let this turn into a gripe session. 
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Trainer Notes Day 2  Agenda 
 
 

Beside each activity is listed the page numbers in the participant’s notebook that the activity 
refers to as well as a rough idea of the time it should take to do the activity. 
 

 Greeting & Previous Day Follow-up 10 minutes 

 Morning Journal & Email Activity… 30 minutes 

 Reading Rebus Rhymes (pages 3-5) 60 minutes 

 Effective Uses of the Internet  (pages 7-24) 60 minutes 

 LUNCH 

 Effective Uses of the Internet  (pages 7-24) 60 minutes 

 Newsletters (pages 25-27) 60 minutes 

 Internet Writing  (pages 28-30) 45 minutes 

 Brain Check (page 31) 10 minutes 
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Rebus Reading Rhyme – Day 1 - page 3 
 

Reading Fun Activity 
Trainer Notes for Rebus Reading Rhymes 

1. Start by introducing the activity. Inform participants that they can choose to do 
this as a whole group activity with students or as a small group activity around the 
classroom computer.  

2. Ask the students if they know what rhyming means. If they are unsure, explain 
that they are words that sound alike and give them several examples. 

3. Tell them that they are going to do a listening activity. Tell the students that 
they will be listening for words that rhyme and when they hear words that rhyme 
they need to give you a thumbs up.  Demonstrate again by saying rhyming pairs 
and non-rhyming pairs and see if they can identify the ones that rhyme. 

4. Turn on the monitor and click on the Bees rhyme. Read the rhyme together 
encouraging the students to join in and make predictions about what comes next.  
See if they can identify the words that would go with the pictures. Read the 
rhyme again and have the students listen for rhyming pairs and give you a thumbs 
up when they hear words that rhyme. Have each child tell one rhyming pair. If 
anyone in the group misses a rhyming pair, go back and read the lines again and 
identify the rhyming words with the students by asking, “Who can find a word 
that rhymes with ______?” 

5. Click the back button and choose 2-3 other rhymes to do the same way. 
6. Conclude the activity by having each student give you two words that rhyme that 

they want to illustrate. Write the one word in each box of the Rhyming Words 
worksheet and have students take the sheet with them back to the workspace so 
they can complete the illustration. If the student is able to come up with an 
original sentence with rhyming words, write it below the boxes. 

7. Allow 10 minutes for people to look around the rest of the site. 
 

Trainer: End of Activity Discussion Rebus Reading Rhymes 
1. Ask participants how they have used the Internet in instruction with PreK 

students? Early Elementary? 
2. Talk about the concerns that  the participants have when it comes to using the 

Internet with young students.  
3. Let them know that your hope by the end of the day all the concerns they have 

will be addressed. 
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Reading Rebus Rhymes 
 
Teaching 
Strategies 
Modeled 

Technology 
Strategies 
Modeled 

Instruction 
Essential Question for Teachers: 
Can I effectively use one computer as an instructional tool in 
my classroom? Can I teach rhyming using Internet resources? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Whole group 
instruction 
 
One 
computer 
classroom 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
http://www.en
chantedlearnin
g.com/Rhymes.
html 
 
 
 
 

Essential Question: 
Can students identify rhyming words? 
Can students read rebus rhymes? 
 
Learning Goals: 
Students listen and identify rhyming words. 
Students read aloud rebus rhymes. 
 
Materials: 
One computer with Internet connectivity 
 
Preparation: 
Test the link and make sure it is working. 
Create small groups of 3-4 students to do this activity. 
 
Procedure: 
 

1. Organize children so that they can see the computer.  
Have the link ready on the computer but the monitor 
turned off so that the students cannot see images on 
the screen. Copy the Rhyming Words I or Rhyming 
Words II worksheet. 

2. Introduce the activity by asking the students if they 
know what rhyming means. If they are unsure, explain 
that they are words that sound alike and give them 
several examples. 

3. Tell them that they are going to do a listening activity. 
Tell the students that they will be listening for words 
that rhyme and when they hear words that rhyme they 
need to give you a thumbs up.  Demonstrate again by 
saying rhyming pairs and non-rhyming pairs and see if 
they can identify the ones that rhyme. 
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Rebus Reading Rhyme – Day 1 - page 4 
 

NOTES 
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4. Turn on the monitor and click on the Bees rhyme. Read 
the rhyme together encouraging the students to join in 
and make predictions about what comes next.  See if 
they can identify the words that would go with the 
pictures. Read the rhyme again and have the students 
listen for rhyming pairs and give you a thumbs up when 
they hear words that rhyme. Have each child tell one 
rhyming pair. If anyone in the group misses a rhyming 
pair, go back and read the lines again and identify the 
rhyming words with the students by asking, “Who can 
find a word that rhymes with ______?” 

5. Click the back button and choose 2-3 other rhymes to 
do the same way. 

6. Conclude the activity by having each student give you 
two words that rhyme that they want to illustrate. 
Write the one word in each box of the Rhyming Words 
worksheet and have students take the sheet with them 
back to the workspace so they can complete the 
illustration. If the student is able to come up with an 
original sentence with rhyming words, write it below 
the boxes. 

7. Bring the next group over and repeat the lesson, but 
change the rhymes used.  Teachers may want to print 
some of these rhymes out to place in a class book for 
the students to read. 
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Rebus Reading Rhyme – Day 1 - page 5 
 

Rhyming Words Worksheet 1 
 

Trainer Notes for Rhyming Words 1 Data Sheet 
Students will write two words in the top boxes. They then need to come up with at least 
3 words for each that rhyme. If they can students should write a sentence using as 
many of the words as possible. 
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Rhyming Words I 
Name_________________________ 
 
 
 
 

 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

__________________________________________________________________ 

__________________________________________________________________

__________________________________________________________________ 

__________________________________________________________________ 
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Rebus Reading Rhyme – Day 1 - page 6 
 
 

Rhyming Words Worksheet 2 
 

Trainer Notes for Rhyming Words 2 Data Sheet 
Pair up students to complete this activity. Have them create a picture story using the 
rhyming words. Show students the examples of the rebus rhymes that are printed out 
or on the Web site.  
 
This activity can also be done using colored markers and  chart paper. This makes for a 
more exciting start to the training day if teachers have to come up with illustrations 
that get hung on the wall.  
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Rhyming Words II 

Name_________________________  
Have partner groups create a pair of rhyming words by each child contributing a word. 
 

My Word My Friend’s Word 
 
 
 

 

 
 
 

 

 
Rhyming Word Picture 
Using the rhyming words from above create a picture story. 
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Searching the Internet – Day 2 – page 7 
 
Trainer Notes – Searching the Web 
Discuss with participants the objectives of the lesson. 

Participant Objectives 
• Locating information on the Internet. 
• Understanding directories. 
• Understanding search engines. 
• Understanding meta-search engines. 
• Learning to save graphics from the Internet. 
• Learning to copy and paste text from the Internet. 
• Learning to organize my favorite sites from the Internet. 

 
How do you know when you find material that it is accurate? Accept answers and discuss 
how information can be verified.  
Searching the Web for facts and information can be tricky at times. Just because it’s 
on the Web does not make it true or accurate. Take a look at the false sites and discuss 
how easily students can be misled.  

• DHMO.org- looked through the site- FALSE site http://www.dhmo.org/  
• Also looked at the Jackelope Conspiracy- FALSE site 

http://www.sudftw.com/jackcon.htm  
• The Pacific Norwest Tree Octopus- FALSE site 

http://zapatopi.net/treeoctopus.html  
• Clones R Us- FALSE site http://www.d-b.net/dti/  
• California Velcro Crop is under challenge- FALSE site 

http://home.inreach.com/kumbach/velcro.html  
 

Trainer Notes – Directories- Yahoo  http://www.yahoo.com 
• Yahoo is a directory 
• Organized in categories. You can browse categories much like a grocery store or 

you can conduct a specific search using keywords or phrases.  
• Open a browser. (You can do this whole group to explain the process and then give 

participants hands-on ore have them go with you on their computers)   Go to 
Yahoo. Sometimes you may be looking for something but not know all the 
specifics. This is when a directory is nice. You can travel through the categories 
searching for what might be of interest to you.  

•   Open Yahoo in your browser, and take participants through a guided browse. 
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Why Use the Internet? 

Before we can begin to explore the effective uses of the 
Internet in classroom  instruction, we must first ask 
ourselves, “Why should teachers use the Internet in the 
instruction of students?”  This question has been 
investigated and reported on exhaustedly for the past 
decade. Even though the answer continues to evolve as 
educators become more accepting of the medium, we find 
that that the core of the answer to that question is, “It’s 
an unlimited resource.” It breaks the bonds of reliance on 
the printed text. We are no longer solely dependent on 
what the textbook companies have to offer.  Educators 
and students have access to an unlimited library of information and are only bound by 
their own creativity as to how to use it.  

It is true that the Internet and the amount of information available to us can be 
categorized as a sort of information explosion, or taking “a drink from a fire hose.” 
However, this has been a technological evolutionary process. Before the Internet, we 
had other information delivery systems. Let’s look at the history of the encyclopedia as 
an example. In 1768, Encyclopedia Britannica published its first Encyclopedia. It had 32 
volumes. In 1989, they published the first encyclopedia on CD-ROM. Today it’s online. 
The print version is still available if you’re ready to fork over $1,396.60 for the 
complete set. Or you can pick-up the entire set plus animations, movies, color pictures, 
animated maps and you can keyword search it, all for under $50 dollars at your local 
Wal-Mart store. Another plus for the CD-ROM is that it will fit in your pocket.  

This example and its timeline are important. In 1768, we have the first commercially 
available printed encyclopedia. Two hundred and twenty one years later, we have it 
printed onto a small, round plastic disc. Just five years later, in 1994, much of it was 
made available free online for anyone with a computer and modem. This is a significant 
shift in how we acquire information in a very short period of time. It took 221 years to 
evolve from print to electronic publishing, but only 5 years to further evolve our system 
of information delivery. I use this example because it highlights the evolution of the 
delivery system, which in some way dictates the use of that system. 

As I continued to explore the initial question, (Why should teachers use the Internet in 
the instruction of students?), I began to realize that the answer was being dictated to 
us by the commercially driven market place. It seems our question is no longer valid.   As 
more and more information becomes cheaply available on the World Wide Web, our 
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Searching the Internet – Day 2 – page 8  
 

o Click on “History” under Arts & Humanities, U.S. History, By Subject, 
Military History, Wars and then Civil War.  

• This will take you through several areas that might have information of interest 
to you based on what you are looking for.  

• Go back to the Yahoo homepage and type “Civil War” into the search box.  
o You are now searching for the Yahoo database for any web page that has 

those words.  Notice you got about 1000 results returned to you.   
o Click the back button and talk about the importance of adding enough 

information in the search box to narrow down the search. Type in “civil war 
battles” and click search. Notice you now have about 200 links. Be clear 
about what your results mean. You have about 200 links that have the word 
“civil”  “war”  “battles” on the page somewhere. It is likely that most of the 
links you will get will be about “Civil War battles” but some may just have 
those words on the page. 

• Make it clear that every search engine is different and has its own way of 
conducting a search of its database.  

 
Google  http://www.google.com  
For Google see page 3 - day 3 Trainer Notes. 
 
Profusion www.profusion.com 
Last type of search engine we will look at is a Meta search engine. Profusion is a Meta 
type search engine.  It searches other search engines.  

• Go to the Profusion search engine, Click on the advanced search engine area. Talk 
about how the advance search area facilitates a better search. Review the 
specific tools. Type in “civil war battles” review what is found. 

 
Copyright links – see www.i3forteachers.com/copyright.htm 
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question clearly must change. Now it sounds more like, “When will teachers begin to use 
the Internet in the instruction of students?”  And “What are the effective uses of the 
Internet in classroom instruction?”  So, once again, we have found ourselves studying an 
education issue long enough for the question to evolve away right before are very eyes. 
The answer now seems much simpler than it did a decade ago. The Internet can provide 
invaluable resources which cannot be delivered using other technologies, books, or 
school resources. 

 



Ready for Reading, Technology Tools in the Pre K – 1st Grade Classroom                                  Trainers Manual  
 

Copyright  2004  i3 Training Services  Inc. 

Searching the Internet – Day 2 – page 9 
 

NOTES 
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Finding and Using Internet Resources 
What is in it for my classroom and me? 

 
• Lesson plans 
• Printable resources 
• Online software 
• Online activities 
• Authors 
• Experts 

• Other teachers 
• Other classes 
• Virtual tours 
• Newsletters 
• Professional information 
• Audio and video clips 

 
The Internet as a Tool for Educators 

 
The Internet has become a major medium of communication and information. 
For teachers the Internet is a particularly valuable tool. There is a lot 
available for teachers that they can grab, adapt, and use which will make 
their work easier and richer. The Internet exemplifies the expression that 
many hands make light work. The key to using the Internet productively is to 
become a savvy, selective surfer of the Web and eventually to contribute 
back to the education community by contributing your ideas and lessons. 
 

How do I Locate Great Stuff Fast? 
Use a Search Utility! 

 
Directories- Libraries on the Web! 

The Browse-Search 
Directories are designed to be browsed. The web links included in a 
directory are selected and organized by people. When you search a 
directory, you search only the material that the directory knows about. 
Directories often provide some level of review for the material included. 
 
Yahoo 
www.yahoo.com 
“The Yahoo! directory is an online guide to the World Wide Web. It is 
created by a staff of editors who visit and evaluate web sites and then 
organize them into subject-based categories and sub-categories.” 
http://help.yahoo.com/help/us/dir/dir-01.html  
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Searching the Internet – Day 2 – page 10 
 

NOTES 
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About.Com 
www.about.com 
“Each site in our unique network is run by a professional Guide who is 
carefully screened and trained by About. Guides build a comprehensive 
environment around each of their specific topics, including the best new 
content, relevant links, How-To's, Forums, and answers to just about any 
question.”  
http://ourstory.about.com/index.htm?PM=59_1100_T 
 

Search Engines 
Ask for What You Need! 

Spiders/Robots who do the looking for you. These are programs that try to 
match the keyword or information a user supplies to a web site. Each does it 
a little differently. Some search the text of web sites. Some search only 
the titles and some search the text that users do not see.  Search engines 
do not determine whether it is a good match or not.  
 
Google 
www.google.com 
“Currently the largest search engine, indexing billions of web pages. It is a 
full-text index that searches the entire HTML file.” 
 
Altavista 
www.altavista.com 
“First, AltaVista checks the words you enter against a massive (half-million 
entry) phrase dictionary to determine which words go together naturally, 
and automatically treats them as phrases. In other words, if you enter 
George Bush or New York or baseball bat, the system knows that those are 
not just random words, and hence looks first for instances where those 
complete phrases appear on Web pages, and puts those pages near the top 
of your list. For instance, DEC tulip (a computer card) is now automatically 
recognized as a phrase; whereas before that query would have generated 
lots of results related to flowers, now such a search gives you much more 
useful results.” 
http://www.altavista.com/sites/help/search/search_help 
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Searching the Internet – Day 2 – page 11 
 

NOTES 
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Teoma 
http://www.teoma.com/  
This new search tool uses something the others don’t to return great 
links to you. Instead of link popularity ranking they use something they 
call “Subject Specific Popularity.” They determine who the experts in 
the field are that understand what you are looking for and then derive 
the link ranking by reviewing what the have linked to. Sound confusing? 
I’m confused and I just spent 20 minutes trying to figure out how to 
explain it. I guess it boils down to trying to determine a trusted source 
and give it more weight in the ranking. What ever they do, it works.  
 
 

Meta Search Engines- Engines that search other engines 
Your Own Personal Shopper 

Meta search engines are programmed to search other search engines and 
return results from those engines. Some allow users to choose the engines 
that are used in the search. Others offer the capability to search for 
different types of material, date ranges, or other languages for the search. 
 
Profusion 
www.profusion.com 
Profusion has recently undergone some changes and come out with a new look 
and functionality. It still searches other search engines. By clicking on the 
advanced feature, it allows users to choose what engines or directories to 
use in the search. One unique feature is the ability to search for pdf. 
Profusion is now offering a directory that users can click through. 
 
Dogpile 
www.dogpile.com 
“Dogpile searches four search engines at a time. Lists of results from four 
engines are displayed on each page. If you do not get at least 10 documents 
matching your query, Dogpile will automatically search the next four engines, 
and so, on until all are searched or 10 matches are found.” Dogpile provides a 
directory and allows users to search for images, audio, ftp files, and a 
variety of specialized searches by choosing from a drop down menu in their 
regular search. Users can look for the Custom Search link on the bottom of 
the home page to choose the search engines Dogpile should use to do the 
search. 
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Searching the Internet – Day 2 – page 12 
 

NOTES 
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Mamma 
www.mamma.com 
“Mamma.com is a "Smart Meta Search Engine." When the user enters a 
query at the Mamma.com website, Mamma's powerful proprietary technology 
simultaneously queries a series of Search Engines and properly formats the 
words and syntax for each source being probed. Mamma then creates a 
virtual database, organizes the results into a uniform format, and presents 
them by relevance and source. In this manner, Mamma.com provides the end 
user with a highly relevant and comprehensive set of search results.” 
 

Specialized Searches 
Not all engines search for all types of materials. There is a term called the 
invisible web that describes resources that are on the World Wide Web, but 
not picked up by search engines.  Material that is stored in databases 
frequently is not searched. Portable document files (pdf) are not always 
picked up in searches. Audio and image files are not necessarily picked up. 
Below is a list of specialized search engines that focus on material on the 
invisible web. 
 
Altavista Images 
http://www.altavista.com/sites/search/simage 
 
Altavista Video 
http://www.altavista.com/sites/search/svideo 
 
Altavista MP3/Audio 
http://www.altavista.com/sites/search/saudio 
 
Google Images 
http://www.google.com/imghp?hl=en 
 
Google File Search 
http://www.google.com/advanced_search 
 
Federal Government Search 
http://www.ed.gov/ 
Don’t miss the Advanced Search for format selection. 
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What strategies should use when I search? 
 
Use More than One 
No one search engine or directory is going to meet all your needs. Think 
about what you are looking for and then try that term in several different 
search engines or directories. There will be overlap in our results, but you 
should locate material more quickly. 
 
Learn How the Search Tool Works 
When you are learning a new engine, look for a section labeled tips or 
information. Take a moment to read how that engine or directory works and 
what special features it may offer. Some engines cache pages so that even if 
the web page you are looking for is no longer available, you can still see it. 
Some allow users to be notified is a page changes. 
 
Broaden or Narrow Your Search  

• Think synonyms. Most engines will not pull “amphibians “ or “tadpole” 
when it is searching for frogs. 

• Engines often are very specific. Some distinguish between upper and 
lower case letters. So “frog” and “Frog” will produce different results. 
So if you are looking for an exact title use capital letters. If you are 
not looking for a proper noun, do not use capital letters. 

 
Combine Terms 
The more specific users can be with what they are searching for, the better 
their results will be. Instead of using just one term in a keyword box, find 
out if the engine you choose allows users to combine terms and in what way. 
 

Combination Technique Example 
Combine terms with “AND” 
or “+” to cause search 
engines to return results 
that have both terms but 
not necessarily next to each 
other 

Kindergarten+math 
 

Kindergarten AND math 

Exclude terms from a search 
using “NOT” or “-” 

Pre-k-school 
Pre-k NOT school 

  



Ready for Reading, Technology Tools in the Pre K – 1st Grade Classroom                                  Trainers Manual  
 

Copyright  2004  i3 Training Services  Inc. 

Searching the Internet – Day 2 – page 14 
 

NOTES 
 



Ready for Reading, Technology Tools in the Pre K – 1st Grade Classroom                                                       Day 2 
 

Copyright © 2004 i3 Training Services Inc.                       inspiring, innovative, integration      14 
 

Search for a phrase using 
quotation marks 

“dramatic play” 

Use an asterisk to pull all 
variations of a word 

write* 

 
Use Advance Search Features 
Look for advanced search functionality in a search engine. Often users will 
find the option to choose the date of the material, the language, the type of 
material, the source of the material, and so forth. In addition, advanced 
searches often provide help with search syntax, which makes combining 
terms easier. 
 
Go Straight to the Source 
Sometimes the best way to locate information is not to use a search engine 
but to go directly to a site that provides that information and search the 
site. Below are some examples for web sites for early childhood educators. 
 
Gayle’s Preschool Rainbow 
http://www.preschoolrainbow.org/ 
 
Preschool Express 
http://www.preschoolexpress.com/index.html 
 
Pre-K Central 
http://prek.dhs.org/ 
 
Alphabet Soup 
http://alphabet-soup.net/ 
 
Kinderart.Com 
http://www.kinderart.com 
 
A to Z Teacher Stuff 
http://atozteacherstuff.com/lessonplans/Grade_K/ 
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Internet Issues and Pointers 
 
Plug Ins 
Plug ins are extra pieces of programming which allows your browser to play 
audio and video files. These do not come with the browser. They will need to 
be downloaded and installed on each computer. Test all links to make sure 
that you do not need a plug in with a site prior to using it with the students. 
 
Acceptable Use Policies 
Check with your school’s policy about Internet use with students. If there is 
an Acceptable Use Policy in place, make sure you have a signed copy for each 
parent on file prior to using the Internet. 
 
Enlarging Your Screen Size 
On a PC to enlarge your web page size click on F11. This hides all the toolbars 
and fills the screen with the web page image. To turn it off click F11 again. 
 
Enlarging Text Size 
If the text is too small for the children, you can increase the size. For the 
Internet Explorer browser, go to the View menu pull down to text size. Click 
on a larger size font and give the browser a minute to adjust. 
In Netscape, go to the View menu and click on Increase Font. 
 
Internet Safety 
Students need to treat the Internet like a stranger and know what 
information is okay to share and what is not. Young children are not going to 
be wandering around on the Internet undirected or unaccompanied, but they 
should know anyway not to give out personal information.  
 
Things Students Should Know 
There are some things that student should know when they go on the web. 
 

Back Key or Arrow-to return to the previous page. 
 

Home Key-to get out of trouble and back to the home page quickly 
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Trainer Notes – Google Advanced Search – Software Helper 
A step-by-step guide to using the advanced searching components of Google.   

• Have participant’s type in www.google.com in their open browser. 
• Red cups up when they see Google site open on their computers. 
• Trainer should talk to the participants about what is available on the site and 

what can be searched. 
• Divide group in half. One group types in “civil war” and the other “civil war 

battles” 
• Review the results. Have participants add words to their search strand at the top 

to narrow down the results. Give them optional words like, “3rd grade”, “lesson 
plans”, ‘north”, “generals”. 

• Review what the participants are getting based on changing the search strand. 
• After finding a link that you like, go back to your Google search page and click on 

“Similar Pages” link next to that item. This will conduct a new search for only Web 
sites like the one that you liked. This is a great tool for narrowing your search.  

• Go back to Civil War Battles 
o Google grades web sites by how many sites link to it.  In other words, what 

Google has done is gauged the quality of the site by its popularity. This 
method seems to be better than someone else doing an outside evaluation 
because you have multiple people choosing the site based on their 
evaluation. With Google you have a built in rating system.   

• Review the “Advance Search” function of Google. I recommend this for all 
beginning searchers because it breaks down the process for them.  Review the 
search category break down and how to fine-tune your search.  

o Exact phrase 
o Without words 
o Format, Date, Domain  

• Find PowerPoint’s about Civil War Battles 
 

Trainer Notes -  
Google Tricks 
Cached: Google takes pictures of all web sites and stores.  If the site is down you will 
still be able to pull up the information you are looking for.  
Google Image Search: Be careful doing this in front of your students.  You don’t know 
what you will get. 
Plagiarism: Finding out who wrote that paper. Go to Google type in exact phrase from a 
students paper that you expect was plagiarized. See if it returns any results.  
Show the kids that you can do this.  They will know how you can catch them. 
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Google Advanced Search Software Helper 
 
Getting Started 
To Open the 
Advanced Search 
Window 

• Click on Advanced Search on www.google.com. 
• The top four fields in the blue box replace Boolean searches. So 

instead of having to construct searches using the + or – symbols, 
Google’s Advanced Search fields performs those functions. 

To Broaden a Search • In the search field next to “with all of the words” type the 
word(s) you wish to search for and then press Google Search. 

• Google will return pages with all the terms you list in the search 
results. 

• Another option would be to put the main term in the top field 
and then list possible additional terms in the field next to “with 
at least one of the words”. 

• In this case Google will look for the top term and include as any 
of the other terms as possible in the search results. 

To Search for a 
Phrase 

• In the field next to “with the exact phrase” type the phrase you 
wish to look for and then press Google Search. 

• Google will conduct a complete text search looking for the 
words in the phrase. 

Interpreting Search Results 
Indented Results • If more that one page from a site fits the search criteria, the 

most relevant page is listed first with the other pages indented 
and listed below it. 

Viewing Missing Web 
Pages 

• Google’s search results include the title of the web page, the 
description of the web page and the URL to link to it. 

• Google also keeps a copy of the web page for itself. If the page 
is no longer available, click on cached next to the URL to open 
and use Google’s copy of the site. 

 Finding Similar 
Pages 

• If one of the 
results is exactly what you want, click on Similar Pages, next to 
cached, to pull up other pages like the one you selected. 

Additional Advanced Search Options 
Choosing a Language • The Advanced Search will return pages in any language.  

• To restrict results to one language, click on the down arrow 
next to that field and select the language. 

Selecting File Format 
Options 

• A powerful option in the advanced search is to restrict the 
search to a specific file format or to exclude that format from 
a search. 

• With the first down arrow next to the File Format field select 
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Only or Don’t. 
• Then click the down arrow next to the second field to search 

for a specific file format. select Only or Don’t. 
• Then click the down arrow next to the second field to search 

for a specific file format. 

o Narrow a Search • In the search field next to “with all of the words” type the 
word(s) you wish to search for and then press Google Search. 

• In the field next to “without the words” type the words that 
should be excluded from the search, then press Google Search. 

To Limit the Date  • If you are searching for material and would like to limit the 
results to only the most current or updated pages, use the 
Date field.  

• The down arrow, next to the date field, allows users to limit 
the search to a time frame for when the page was last updated. 

To Restrict a Search • The occurrences field allows users to tell Google where to look 
for the terms listed in the search boxes 

Using the Domain 
Feature 

• Using the domain features allows users to restrict a search to 
specific web site or type of site. For example, limiting a search 
to URL’s that end in edu will return results that are identify 
themselves as being a school. 

Filtering • Google provides the option to use a filter on searches to 
eliminate unwanted to material from the results. 

• Be aware that the filter is effective but not perfect! 
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Trainer Notes – Saving Internet Graphics 
This is a software helper for participants to following when saving Graphics from the 
Internet. 
 
Participants will be saving a graphics from the Internet for their animal and 
newsletter activity later today. This is the step-by-step direction that the Trainer 
will use to take participants through the process. 
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How to Save Graphics from the Internet 
 

1. Find a graphic on the Internet that you would like to save. 
2. Right click on the image you would like to save and select Save Image As.  

On the Mac just click and hold on the graphic and choose “copy to disk” 
3. Change to the appropriate drive.  A file name should appear.  Click Save.        
 
The graphic was either saved with a .GIF or .JPG extension.  In order to pull 
the graphic into some Windows programs (ClarisWorks 4.0, Student Writing 
Center, Kid Pix Studio), the file needs a .BMP extension.  You must open the 
file in a paint program which allows you to convert the graphic to a .BMP 
format.  Paint Shop Pro is one example of such a program.  Conversion is 
unnecessary if your program will accept graphics with a .GIF or .JPG 
extension.  ClarisWorks 5.0, Kid Pix Studio Deluxe, and HyperStudio will 
allow you to use graphics with a .GIF and .JPG extension.  The change is not 
necessary if you are inserting the graphic into Microsoft Word. 
 
4. Minimize Netscape. 
5. Open Paint Shop Pro. 
6. From the File menu, select Open. 
7. Select the appropriate drive and click on the graphic you just saved. 
Click  OK. 
8. The graphic should appear on your screen. 
9. Under the FILE menu, drag down to SAVE AS. 
10. Change the List Files of Type box to .BMP - Windows Bitmap. 
11. Click OK. 
12. Look on the Title Bar. The graphic should now have a file name that ends 

in .BMP. 
13. File, Exit. 
 
You should be able to pull your graphic into other programs.  This is a great 
way to create a graphics folder for a theme or unit of study. 
 
* You should get permission to use any graphics that you save or copy from 
the Internet in order to comply with copyright laws. 
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Trainer Notes – Saving Internet Graphics 
This is a software helper for participants to following when copying & pasting  
Graphics from the Internet. 
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How to Copy/Paste Graphics from the Internet 
 

You must use Microsoft Internet Explorer in order to copy/paste graphics 
from the Internet. Netscape will only let you SAVE the graphics--not copy 
and paste them. 
 
1. Open Microsoft Internet Explorer.  
2. Locate the graphic you wish to copy. 
3. Right click on the graphic (on a Mac just click and hold).  A menu will 

appear. 
4. Choose Copy. 
5. A copy of the image is placed on the clipboard. 
6. Open the document in which you wish to paste the image. 
7. From the Edit Menu, choose Paste. 

 
Occasionally, using Internet Explorer to copy graphics from a PC results in a 
distorted image.  The colors don’t always paste into a document as they 
appeared on the Internet.  In such cases, you should save the image from 
the Internet rather than copying and pasting.  You may then have to convert 
the graphic using Paint Shop Pro or some other draw program to a .bmp 
format in order to use it in your program. 
 
Copying and pasting is an easy way to get a quick graphic from the Internet.  
If you’d like to create a graphics folder, you’ll need to save the graphics 
from the Internet rather than copying and pasting. 
 
* You should get permission to use any graphics that you save or copy from 
the Internet in order to comply with copyright laws. 
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Trainer Notes – Copying and pasting text from the Internet 
This is a step-by-step guide for copying and pasting text from the Internet. 
 
Copying and pasting is an easy way to get text from the Internet.   
 
Remember to follow copyright laws and give credit to the Web page from which you took 
the text.  See page 21 for how to Cite Resources. Also show them the copyright 
resources at  www.i3forteachers.com/copyright.htm  
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How to Copy/Paste Text from the Internet 
 

1. Open Netscape or Internet Explorer. 
2. Locate the text you wish to copy. 
3. Highlight the text. 
4. From the Edit Menu, choose Copy. 
5. A copy of the text is placed on the clipboard. 
6. Open the document into which you wish to paste the text. 
7. Click to plant the cursor where you would like to paste the text. 
8. From the Edit Menu, choose Paste. 

 
Copying and pasting is an easy way to get text from the Internet. However, 
you should be mindful of copyright laws and give credit to the Web page 
from which you took the text. 
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Trainer Notes – Citing Resources from the Internet 
This is a resource from Classroom Connect that will help you and your students know 
how to cite Internet sources. 
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How to Cite Resources from the Internet 
 
1. World Wide Web 
Structure: 
Author. Title of item. [Online] Available http://address/filename, date of document or 
download. 
Example: 
Schwartz, Robert. The Cold War Revisited: A Splintered USSR. [Online] Available 
http://usa.coldwar.server.gov/index/cold.war/countries/former.soviet.block/, November 
1, 1998. 

 
2. Email/LISTSERVs 
Structure: 
Author of email message. Subject line of the message. [Online] Available email: 
Student@address.edu from Author@address.edu, date of document or download. 
Example: 
Rule, Christopher. Nile River Research Project results. [Online] Available email: 
student5@smallvillehigh.edu from ert@informns.k12.mn.us, October 2, 1998. 

 
3. Images/Graphics 
Structure: 
Description or title of image. [Online] Available http://address/filename, date of 
document or download. 
Example: 
Butterfly. [Online Image] Available http://www.kidsdomain.com/holiday/spring/clip.html/ 
butterfly.gif, October 23, 1998. 
 
4. Sounds 
Structure: 
Description or title of sound. [Online Sound] Available http://address/file, date of 
document download. 
Example: 
Reflections on Apollo. [Online Sound] Available ftp://town.hall.org/radio/ 
IMS/NASA/100394_nasa_01_ITR.au, September 25, 1998. 
 
5. Video Clips 
Structure: 
Description or title of video clip. [Online Video Clip] Available http://address/file, date of 
download. 
Example: 
Shoemaker-Levy Comet enters Jupiter’s atmosphere and breaks up. [Online Video Clip] 
Available ftp://ftp.cribx1.u-bordeaux.fr/astro/anim/s19/breakingup.mpg, September 5, 
1998. 
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Trainer Notes – Setting up an online bookmark account. 
This is a step-by-step resource that participants will follow to organize favorite 
bookmarks from the Internet.  
 

1. Use this step-by-step with participants to set up their own iKeeps bookmark 
account. 
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Setting Up a iKeep Bookmark Account 
 

1. Go to http://www.ikeepbookmarks.com by typing it in the location 
box of your Internet browser.  Press the Enter or Return key. 

2. Click on Click Here to Register.  

 
3. Type an account name. Your account name needs to be something that 

you can remember easily, such as the username that you use for your 
e-mail account. 

4. Enter an authoring password for your account.  You may want to use 
the same password that you use for your e-mail account so you can 
remember it. You will be asked to type the password a second time to 
confirm it. 

 
My Account Name: 
My Authoring Password: 
 

5. Click in the box next to Remember my Login to deselect that option on 
this computer if it is not a computer that you use exclusively. 

6. Choose Account Type from the drop down list. 
7. Click on Finished when you have completed the Contact Details at the 

bottom of the registration screen. The following screen will appear.  
8. Write the link to your account in your plan book or someplace so that 

you can get back to it easily. 
9. Click on option 2 to go to the home page for your account and to start 

adding links right away or option 1 to upload your links from your 
computer to your Ikeepbookmarks account. If you choose not to 
upload your bookmarks now, you can do so later. 
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To Add Links to Your Account 
 
1. From the main page of your account click on Add. 
NEED AN IMAGE FOR THIS WITH AN ARROW 
 
2. The following screen will appear. Type the title of the link. Copy and 

paste the URL for the link into that field making sure that there are 
not two http://s in the field.  
A description of the link is optional but useful when the numbers of 
links grows.  

 
 

3. When the information for the link is complete, click Finished at the 
bottom of the entry screen. 

 
Notice that the links automatically appear in alphabetical order. From the 
main page, you can choose a different arrangement for your links by 
changing the drop down box next to the Add button for the links. 
 
To Organize Bookmarks 
 

1. From the home page click Add right underneath the words “These 
buttons, below, allow you to add or edit folders.”  The following 
screen will appear. 
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2. Type the name of the folder and when you are done click Finished. You 
can create separate folders for classes, subjects or topics or any 
grouping that you can think of. 

3. To add links into a specific folder, open the folder first before 
clicking the Add button. 

4. Or, if you already have links that need to be organized, click the Edit 
button next to the list of existing links. 
 
Click in the empty box next to the title of the link. A green checkmark 
will appear. 
On the left-hand side in the gray box, change the Destination Folder 
to the one the link should move to then click on the Move button. 
When you are back at your home screen, a new number should appear 
next to the folder you moved links into. 

 
To Upload Bookmarks from a Computer 
 

1. On the top of the page, next to red Ikeepbookmarks.com logo, click on 
Bookmarks from the list of menu options. 

2. Two choices appear on the screen.  Click on Upload Bookmarks to the 
Web and the following screen will appear. 

3. Choose the first option to upload all the existing favorites from the 
web browser you are using to the bookmark folder. Simply click on the 
arrow and wait. A box will appear letting you know if it was successful. 

4. Other options on the upload page allow users to upload only  
new material or to replace existing bookmarks in the ikeep bookmarks 
account with the ones from the browser on the computer that you are 
using.  Choosing to use the replace option will wipe out your existing 
bookmarks in you account and put new ones from your browser in 
there.  
 

Optional Features 
 
The Options menu allows you to give people access to your bookmarks. 
Choose Options from the menu next to the red l Ikeepbookmarks.com 
logo at the top of the web page. Select a password for the visitor and 
set up the visitor’s access options. The Options menu will allow you to 
share your bookmarks without other people.  



Ready for Reading, Technology Tools in the Pre K – 1st Grade Classroom                                  Trainers Manual  
 

Copyright  2004  i3 Training Services  Inc. 

Customizing Newsletters – Day 2 - page 25 
 
In this section of the training you can choose to do several different things. See below 
for options. 
 
Option #1 
Discuss how and why teachers might want to use newsletters to communicate with 
parents. This can be done by showing several examples of on-line and printed 
newsletters. You can also show them all the resources available through on-line 
newsletters for teachers.  
 
Option #2 
Discuss how and why teachers might want to use newsletters to communicate with 
parents. This can be done by showing several examples of on-line and printed 
newsletters. You can also show them all the resources available through on-line 
newsletters for teachers.  Show teachers where several newsletter templates can be 
downloaded from and walk them through the customization of them newsletters. The 
following skills should be taught. 

• Downloading templates 
• Finding and harvesting clip art from the Internet 
• Changing text in a word document 
• Using the Word Art feature in MS Word 
• Printing 

 
If using a downloaded template make sure you stress that this is a quick and easy way to 
get a newsletter. Don’t do the work someone else has already done for you.  
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Customizing a Newsletter 
 
An important component of early childhood education is communication. 
Often teachers write newsletters by hand. What we are going to do now is 
customize several templates for you to use to make your life easier and to 
add sparkle to your thoughts. 

 
Georgia Learning Connections 
http://www.glc.k12.ga.us/trc/  
 
1. Click on Teacher Templates and then Newsletters. 
2. Open a newsletter and go up to your File menu and drag down to Save 

As. Choose where you want to save the file. 
3. Go to where the newsletter is located and open it to make changes. 
 
 
Clipart for Newsletters 
 
Discovery School Clipart Gallery 
http://school.discovery.com/clipart/index.html 
  
Kids Domain 
http://kidsdomain.com/clip/index.html 
 
Grandma George 
http://www.grandmageorge.com/ggfree.html 
 
Anne’s School Days 
http://d21c.com/AnnesPlace/School.html 
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 Newsletters 
 
Teacher Vision 
http://www.teachervision.com/lesson-plans/lesson-6398.html?cb2 
The Learning Network provides this collection of online newsletters. 
 
Carol Hurst’s Newsletters 
http://www.carolhurst.com/newsletters/newsletters.html 
Carol Hurst is an excellent source of information on children’s literature. 
She puts out a monthly newsletter with info on new books. These can either 
be emailed to you or read on her site. Scroll down to see the newsletters. 
 
Child Fun 
http://www.childfun.com/lists/ 
This is a large collection of newsletters from a site which provides plenty of 
resources for early childhood educators. Scroll down to the bottom of the 
page to find the newsletters. Try subscribing to one to see the actual 
newsletters. 
 
Surf Net Kids 
http://www.surfnetkids.com/preschool.htm 
Barbara J. Feldman writes a weekly newsletter highlighting sites on the web 
that are appropriate for children. Each week is a different topic. This one is 
on games for preschoolers. 
 
Family Corner. Com 
http://www.thefamilycorner.com/dir/Education/Preschool/ 
This site has good information for parents and newsletters with creative 
ideas. Scroll down and look on the left hand side to find the newsletters. 
Choose one and enroll to see the content. 
 
Teach-nology Newsletters 
http://www.teach-nology.com/newsletters/ 
This education technology site has a wealth of resources including 
newsletters. 
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Review the 3 sample free Web page sites 
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Communicating with Web Pages 
 

For communities that have computers and are using the Internet, web pages 
can be an effective way to stay in touch with parents and showcase your 
student’s talents. Teachers do not need to know html to create pages they 
can share. Simple wizards and online tools allow you to create and update 
web pages easily. 
 
 
Teach-nology Build a Free Web Site 
http://teachers.teach-nology.com/web_tools/web_site/ 
A wizard walks you through the process of creating your own web site. 
Teach-nology hosts the site so that teachers do not have to figure out 
where to post their web site. 
 
School Notes. Com 
http://www.schoolnotes.com/ 
Copernicus provides this free resource for creating and hosting teacher-
created web pages. 
 
Scholastic Teacher Homepage 
http://homepage.scholastic.com/classpages/studentparentsignin.cfm  
This site makes it easy for teachers to create and post a web site. 
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Trainer Notes for Internet Writing 
This is also a small group activity but can be done whole group to introduce the ideas.  
 
Make sure that you have checked the Panda site at lunch and that it is working. I leave 
mine up and minimized so I can check throughout the day.  Let student’s know we will be 
using software that we have used before called Kid Pix. Review some of the terms and 
functions.  
 
**You will need laminated sentence strips for this activity so students can draft the 
sentences for their story.  
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Internet Writing 
 

Teaching 
Strategies 
Modeled 

Technology 
Strategies 
Modeled 

Instruction 
Essential Question for Teachers: 
Can I locate and plan an activity with an Internet 
resource? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Small group  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
http://www.sa
ndiegozoo.org/
pandas/pandac
am/index.html  
 
 
 

Instruction 
Essential Question: 
Can I use an Internet resource to teach writing skills? 
Can students work together to compose a story? 
 
Learning Goals: 
Students will respond to images and develop a group 
story. 
 
Technology Connections: 
One computer with Internet connectivity 
Kid Pix 
 
Preparation: 
Test the link to make sure that it is working. 
Have sentence strips ready and a marker ready for 
writing. 
 
Procedures: 

1. Have the link up and Kid Pix started on the 
computer you will be using. Turn the monitor off. 

2. Have 4-5 students come and sit where they can 
see the computer. 

3. Introduce the activity by asking students what 
types of stories they like to hear. Generate a list 
with them using 1 -2 descriptive words. 

4. Tell them that today they are going to create a 
story. Have them discuss and add elements that 
will make their story exciting and interesting. 
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NOTES 
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Front page of 
Panda site 
 
 
 
http://www.sa
ndiegozoo.org/
special/pandas
/bai_yun/baiy
un_slideshow.h
tml 
 
Bai Yun Slide 
Show 
 
 
National Zoo’s 
Panda Cam 
http://pandas.
si.edu/pandaca
m/ 
 

5. Tell the students that you have chosen the main 
character of the story and that you have 
pictures to help them get started. 

6. Turn on the monitor and bring up the Panda site. 
The San Diego Zoo page takes visitors to the 
Panda cam. Ask the students if they know what 
animal this is. If they do not, tell them that it is 
a Panda and that pandas live in China. Tell them 
that they are watching the pandas live on the 
screen.  Click on Panda Profiles and read the 
first sentence or two about each panda to the 
students. Do not read the whole description as it 
gets into breeding issues. 

7. Tell the students that their main character for 
their story is Bai Yun. Click on Panda Gallery and 
choose Bai Yun Slide Show. Allow the students to 
watch the slide show run through the images a 
couple of times having the students tell you what 
Bai Yun is doing. Ask the students to think about 
what type of story they would tell about Bai Yun. 
Encourage them to talk about this as a group and 
help them sketch out the bones of a story. 

8. When the students are ready have the first 
student say a sentence, write it on the sentence 
strip. Post it where the whole group can see. 
Have the second student offer a sentence, write 
it on a sentence strip, and place it below the 
first. 

9. When each child has contributed a sentence to 
the story, read through the sentences and talk 
with them about the story they have created. 
Move sentences around or add words to make the 
story flow. Tell the students that their next 
step is to plan the picture for their sentence. 
Take the sentences down. Write the student’s 
name on the back and give them a blank piece of 
paper to plan their picture on. 

10. The next day bring the group back together with 
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NOTES 
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their story boards and sentences. Have Kid Pix 
up on the computer but the monitor turned off. 
Lay the sentence strips and story boards out and 
read the story out loud to the students. Then 
introduce the students to the Kid Pix program by 
starting Kid Pix and typing the first sentence in 
using the text tool.  Save the picture with the 
child’s name and PS for panda story on it. If you 
have 2 -3 computers in your class, start other 
students as well. 

11. Have the students raise their hand when they 
have completed the task.  Do not close the 
pictures.  Review them with the students and 
print. 

12.  When the book is complete, have the authors 
share it with the rest of the class along with the 
slide show they used for inspiration. 
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We will use our new found searching strategies to find 2-4 Web sites that can be used 
by students to complete the assignment. The lesson is written for a cd-rom resource 
instead of the Internet. Give participants directions on how to conduct a search to find 
habitat sites for young students.  
 
Introduce Inspiration software and guide participants through creating their own web 
worksheet. 



Ready for Reading, Technology Tools in the Pre K – 1st Grade Classroom                                                       Day 2 
 

Copyright © 2004 i3 Training Services Inc.                       inspiring, innovative, integration      31 
 

Water Habitats 
 

Teaching 
Strategies 
Modeled 

Technology 
Strategies 
Modeled 

Instruction 
Essential Questions for Teachers:  How do I use 
Inspiration to create graphic organizers?  How do I use a 
CD-Rom with a whole group?  How do I use Kid Works or 
Student Writing Center?  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Essential Question:  
What animals live in water habitats?  Where are these 
habitats located?  
 
Learning Standards (State of Michigan): 
Assessed:  
Science Standard V.2:  Elementary 
Trace the path that rain water follows after it falls. ( Key 
concepts: Precipitation-rain, clouds, fog, run-off. Flow-
downhill, to ocean, underground. Bodies of water-streams, 
rivers, lakes, oceans. Real-world contexts: Examples of 
water flowing locally, including gutters, drains, streams, 
wetlands.) 
 
Science Standard III.5:  Elementary 
Describe the basic requirements for all living things to 
maintain their existence. ( Key concepts: Needs of life-
food, habitat, water, shelter, air, light, minerals. Real-
world contexts: Selected ecosystems, such as an aquarium, 
rotting log, terrarium, backyard, local pond or wetland, 
wood lot.) 
 
English/Language Arts Standard 7: Early Elementary 
Begin to develop and use strategies for planning, drafting, 
revising, and editing a variety of text forms. Examples 
include identifying characteristics of their audience, 
mapping, and proofreading. 
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NOTES 
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Teaching 
Strategies 
Modeled 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Whole 
Group 
Instruction 
 
 
 
Partner 
Activity 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Technology 
Strategies 
Modeled 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Eyewitness 
Encyclopedi
a of Nature 
CD 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Non assessed: 
English/Language Arts Standard 11: Early Elementary 
Generate questions about important issues that affect 
them or topics about which they are curious, and use 
discussion to narrow questions for further exploration. 
 
 
Materials:  
Eyewitness Encyclopedia of Nature CD, sentence strips (K-
2), reproducible student materials, Inspiration, 
Kidspiration(K-2), scan converter, large classroom map 
 
Technology Connections:  
Students will view information from a CD and observe the 
teacher creating a web in Inspiration.  The teacher will 
model how to type sentences in Kidspiration(K-2)  
 
Procedures:   
1. Ask students to name animals that live in the water 

habitats that they have been studying. We are going to 
be focusing on Oceans & Lakes. Write the animal names 
on the board as the students call them out.  

2. Explain to students that, in pairs, they will be using the 
Eyewitness Encyclopedia of Nature to identify the 
animals located on the activity sheet that follows. 

3. Instruct students on the use of the CD. Click on 
Habitats and show students the Sea & Coast, Coral 
Reef and Lake & Wetland habitats.  Explain that the 
animals in the Sea & Coast habitat and in the Coral 
Reef habitat are all ocean animals.  Click on various 
animals in each habitat and discuss the information 
presented. 

4. Students use the animal activity page and identify each 
animal as Lake or Ocean animals. Print an L or O in the 
right hand corner of the animal picture identifying it as 
a Lake or Ocean habitat animal. 

5. Cut-out the animals out and paste them on the web 
activity sheet. 
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NOTES 
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Whole 
Group 
Demo 
 
Center 
Activity 
 
 

 
Kidspiration 
 
 
 
 
 

6. Have your students choose one animal to write a 
sentence about. Print sentence on a sentence strip.  

7. Model the use of the software Kidspiration writing the 
sentence from the sentence strip. 

8. Students rotate through the computer station entering 
in their sentence and printing it out. 

 
Assessment:  
Students will be assessed on the accuracy of their webs 
and participation in creating a class booklet. 
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Day 2 - page 34 
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Water Habitats Fact Gathering Sheet 
Write down facts about three animals from each habitat. 

 
 
Sea & Coast- 
 
 
 
 
 
 
 
 
Coral Reef- 
 
 
 
 
 
 
 
 
Lakes & Wetlands- 
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 Habitats Web 
Cut out the animals from the second page and glue them next to the correct 

habitat. 
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Animal Cut-outs 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Frog 

Snail

Sea Snake

Newt Stickleback
Puffin 

Duck 

Moorish Idol

Dolphin

Pilot Whale 
Lobster

Beaver 
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Trainer Notes – The Brain check is used to assess the participants’ knowledge of 
the use of the daily technologies.  This should be adapted by each instructor to 
match the selected software. 
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Brain Check 
 

1. If you do not want to create a newsletter from start to finish, what 
can you use? 

 
 
 
2. In MS Word how do you insert a graphic? 
 
 
 
 
3. What Word function can you use to create a title for your 

newsletter? 
 
 
 
 
4. Where can you create a web page using a simple online, fill-in-the-

blank form? 
 
 
 
 
 

5. When you are using your browser which key allows you to make the 
screen larger? 

 
 
 
 
 

6. How can you make the text size larger in Internet Explorer? 
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Daily Closure  
 

Trainer Notes –  
• Recap the day.  
• Take questions that participants have.  
• Assign Homework 
• Have participants straighten up their area. 
• Shut down computers 

 
 

 
End of the Day 

 Have people go into their email and have them reflect on the day and what pieces 
or ideas they would like to try in their rooms. They need to print the email and 
then send it to you so that you have all of their addresses and can send them a 
greeting in the morning. 

 Wind up the day by talking with them about how they are doing. Answer any 
questions they have. Then do the Brain Check on page 37 as a whole group. 

 
 
 

Be sure to end the day on a positive note!!! 
 




